Export TimeCode2 for gma2

“(OF) COURSE

This is simple tool to Export Cue List (Sequence) with Timecode to the grandMA2.

Change Cue Number, Cue Color, Cue Fade or Info from within the application. You can also print your Cue List (Sequence).
Just import to Reaper multimedia file (music or video) you’re working on.

Prepare all Cues (Markers in Reaper) — light changes, accents, solos, etc. that you want to use in show.

Export TimeCode2 for gma2 will finish all work for you by importing to console Of Course:
— Timecode number

—Timecode name

—FPS

— Page number

—Page name

— More than one Cue List (Sequence)
— More than one Track in Timecode
—Sequence number

—Sequence name

— Executor number

— Cue Color

— Cue Fade

— Cue Info

As simple as that!
Don’t miss that chance! Do not hesitate and try it completely for free!

Description:

Download and install "Reaper":
http://www.reaper.fm/download.php

Download and install "SWS Extension" for Reaper:
http://www.sws-extension.org/

Run Reaper.
1. Open File tab and Project settings.

@ REAPER File Edit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : 0/2ch 512spls ~11/20ms] Pt.3.01 22:05:33 jolo Q @ =

New project ID Description
New project tab

Open project...

Save project

Save project as...

Save new version of project

Save all projects

Project templates
Recent projects

Close project
Close all projects

Project settings...

Render...

Open render queue

Region Render Matrix

Batch file/item converter {38F
Save live output to disk (bounce)... 3B

Consolidate/Export tracks...
Export project MIDI...

Clean current project directory...

Regions
L v Markers
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Filter: Clear
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2. Set Frame rate (FPS) the one you want to use in the show.

. OfCourse_ExportTC [modified] - REAPER v6.02/64 - Registered to Grzegorz Barszczewski (Licensed for personal/small business use)

Project Settings

Project Settings

]
23.976

Preferred videc X
24

Frame rate: 30

Video item visil 25
29.97DF ~

Video colorspa g o\ <

Aways resiECIIR o oreferred video size
Always resi 48 rred video size

50
Use high qt g

Preserve as 75

n resizing

10x) when resizing

Cancel

3. Open View tab and set Time unit for ruler to Hours:Minutes:Seconds:Frames.
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4. Open Insert tab and insert Track.

Media QRIEELEY Advanced

ID Description

Notes

lower numbered tracks replace higher

Save as default project settings
Regions
v Markers

End Length
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@ REAPER File Edit View Insert Item Track Options Actions Extensions Window Help [44.1kHz 24bit WAV : 2/2ch 512spls ~13/20ms] 100% @@ Pt. 27.03 16 37 12 jolo Q ®
Media file...
New MIDI item
Empty item
SMPTE LTC/MTC Timecode Generator
Click source

New subproject

Marker
Marker (prompt for name)

Tempo/time signature change marker

Track

Multiple tracks...

Virtual instrument on new track...
Track from template

v Regions
Markers.

Render Matrix...

Length

Filter:

5. Open Insert tab and Import your media file.
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Media file... @ ID Description
New MIDI item
Empty item
SMPTE LTC/MTC Timecode Generator
Click source

New subproject
Marker

Marker (prompt for name)

Route

Tempof/time signature change marker

Track

Multiple tracks...

Virtual instrument on new track...
Track from template

Regions
v Markers

End Length

Filter:




6. Create a Cue List (Sequence) use the Markers and give the names for Cues. Important: don’t use comma (“,”) in cue name.

OfCourse_ExportTC [modified] - REAPER v6.02/64 - Registered to Grzegorz Barszczewski (Licensed for personal/small business use)

ID Description

:00:00 1 pre show
4:05 2 start

Add Marker

Name: | hit|

Position:  0:00:06:07

Set color... Reset color

Regions
v Markers
#~ Name Start End Length
M1 pre show 0:00:00:00
M2 start 0:00:04:05

Filter:

7. Save Reaper Project.

8. Open View tab and open Region/Marker Manager.
9. Click right mouse button and use the tab Export region/markers, name the text file (*.csv) and save it.

Description

pre show

start

hit

hit

hit

hit

verse
0:00:22:28 chorus
0:01 3 frase
0:00:31:09 solo

Route

[ JoX J Region/Marker Manager

Regions
Markers
#~ Name Start End Length
[C] M1 pre show 0:00:00:00
= Al
Delete selected markers/regions
Renumber in timeline order (markers, then regions)

Import regions/markers (replace existing)
Import regions/markers (merge with existing)...
Export regions/markers...

0:00:

0:00:22:28
0:00:27:03
0:00:31:09

v Seek playback when selecting a marker or region
Play region through then repeat or stop when selecting a region

Dock Region Manager in Docker

Close window




Your Cue List (Sequence) with Timecode is ready and now. You can export it to the grandMA2 use Export TimeCode2 for gma2.
Run Export TimeCode2 for gma2.

Export TimeCode2 for gma2
Track 1

Fade Color Info

You are logged with Apple account

1. Click tab Settings.

2. Set directories for Timecode (importexport) and Macro — grandMA2 OnPC Folders or USB Memory Stick Folders.
3. Set directories for Projects file, default is yours document folder.

4. You can also set default Fade for Cues.

5. Save settings.

Export TimeCode2 for gma2

Settings
Document folder (for repaer file)
/Users/makus/Documents/ExportTimeCode2/Projects/ Browse
Export folder (default for macro: gma2/importexport, for timecode: gma2/importexport)

/Users/makus/Documents/ExportTimeCode2/ Browse

Default fade time 2.00

Purchase of subscription is possible only after logging into the account in the icati In addition to pi , the account
gives the ability to synchronize settings, access information on new products, faster and more reliable contact with support. We
never send you email and Export TimeCode2 is 100% ad free.

You are logged with Apple account. (click to logout)

Version: Full version for three months
show tutorial on StartUp

Reset to default

You are logged with Apple account

Timecode number

1
Timecode label
TimeCode
FPS
30

Page number
1

Exec number
1

Sequence number
1

Sequence label
CuelList 1

Page label
Page

Add new track

Delete track

Settings
Help

Our Apps
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FPS
30
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Exec number
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Sequence number
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Sequence label
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Page

Add new track

Delete track

Settings
Help

Our Apps




6. Click tab ‘Add new track’ and select your Cue List (Sequence).

Directly from Reaper Project.

Export TimeCode2 for gma2

Fade Color Info

Timecode number
1
Timecode label

TimeCode

FPS
Favorites Name Date Modified Size Kind 30

E) Recents OfCourse_ExportTC.RPP 27 marca 2020 15:50 6 KB  ReaperPr
B ofCourse_ExportTC_markers.csv 27 marca 2020 15:23 220 bytes comma...)
OfCourse_ExportTC_Video.RPP 27 marca 2020 15:21 5 KB
El OfCourse_ExportTC_Video_markers.csv 27 marca 2020 15:21 149 bytes
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Page label
Page

@ OneDrive
@ OneDrive - iglo...

iCloud Add new track

New Folder Cancel Open Delete track

Settings
Help

Our Apps
You are logged with Apple account

Or, from exported text file from Reaper Project (*.csv).

Export TimeCode2 for gma2

Fade Color Info

Timecode number
1
Timecode label

TimeCode

FPS
Favorites Name Date Modified Kind 30

D Recents OfCourse_ExportTC.RPP 27 marca 2020 15:50 6 KB ReaperPri
S E| OfCourse_ExportTC_markers.csv 27 marca 2020 15:23 220 bytes

A\ Applications . .
OfCourse_ExportTC_Video.RPP 27 marca 2020 15:21 5 KB
Downloads B ofCourse_ExportTC_Video_markers.csv 27 marca 2020 15:21 149 bytes
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(CONMINEES) Page number

1

Exec number
1

Sequence number
1

Sequence label
CuelList 1

ReaperPr

comma...
@ ownCloud

£ Movies

J Music

[ Pictures

12} makus

0 iOSProjects

B TC&TT_2020

@ OneDrive

Page label

Page

@ OneDrive - iglo...

iCloud Add new track

New Folder Cancel Delete track

Settings
Help

Our Apps
You are logged with Apple account




As a result, you will see your Cue List (Sequence).

Name

pre show
start

hit

hit

hit

hit

verse

chorus

© 0O N O O b WN =

frase

solo

—
o

You are logged with Apple account

Time
00:00:00:00
00:00:04:05
00:00:06:06
00:00:08:10
00:00:10:13
00:00:12:16
00:00:14:18
00:00:22:29
00:00:27:06
00:00:31:09

Now you can change the Name, Number, Fade and set Info or Color for cues.

Name
pre show

start

Time
00:00:00:00
00:00:04:05

Export TimeCode2 for gma2

Track 1

Fade
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00
2.00

Export TimeCode2 for gma2

Track 1

Fade
2.00
2.00

Color

Track 2

Color

Info

Info

hit
hit
hit
hit

verse

chorus

© O NJO O B WIN =

frase

solo

=
o

You are logged with Apple account

00:00:06:06
00:00:08:10
00:00:10:13

2.00
2.00
2.00
2.00

change fade time
change color
change cue name
change info
remove cue

2.00
2.00
2.00
2.00

Guitar

Timecode number

1
Timecode label

TimeCode
FPS

30

Page number

1
Exec number
1
Sequence number
1
Sequence label
Cuelist 1
Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps

Timecode number
1

Timecode label
TC

FPS

30

Page number
1

Exec number
1

Sequence number
1

Sequence label
Light

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps




8. Do not forget to set Timecode number, Timecode label, Page number, Executor number, Sequence number, Sequence label, Page label.

Export TimeCode2 for gma2

Track1  Track 2

Timecode number
1

Timecode label

Fade
2.00

2.00 e
2.00 FPS

Name Time Color Info

pre show 00:00:00:00
00:00:04:05
hit 00:00:06:06
hit 00:00:08:10
hit 00:00:10:13
hit 00:00:12:16
verse 00:00:14:18
00:00:22:29
00:00:27:06
00:00:31:09

start

2.00 |8
2.00
2.00
2.00
2.00
2.00
2.00

Page number

1
Exec number

1
Sequence number

1

chorus

© 0O N O O b WN =

frase

solo Guitar

=
o

Sequence label
Light

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account

9. You can now import another track (Sequence) into the same Timecode.

Export TimeCode2 for gma2

LCE &M Track 2

Timecode number

Favorites
[E Recents
A\ Applications
Downloads
@®. ownCloud
=1 Movies
n Music
)] Pictures
12} makus
B iOSProjects
8 TC&TT_2020
@ OneDrive
@ OneDrive - iglo...
iCloud

New Folder

You are logged with Apple account

Fade

# Projects

OfCourse_ExportTC.RPP

OfCourse_ExportTC_markers.csv
OfCourse_ExportTC_Video.RPP
OfCourse_ExportTC_Video_markers.csv

Color Info

& Q Se

Date Modified

27 marca 2020 15:50
27 marca 2020 15:23
27 marca 2020 15:21
27 marca 2020 15:21

Size
6 KB
220 bytes
5 KB
149 bytes

Cancel

Kind
ReaperPr
comma...\
ReaperPr|

comma...|

Open

1
Timecode label
ic
FPS
30

Page number
1

Exec number
2

Sequence number
2

Sequence label
CuelList 2

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps




As a result, you will see Cue Lists (Sequences) — Tracks in Timecode.

Name

pre show
movie 1
movie 2
movie 3
movie 4

end

You are logged with Apple account

Now you can change the Name, Number, Fade and set Info or Color

Time
00:00:00:00
00:00:04:05
00:00:11:14
00:00:18:23
00:00:26:03
00:00:31:09

for cues.

10. Do not forget to set, Executor number, Sequence number, Sequence label.

You can also print Cue Lists (Sequences).

Name

pre show
start

hit

hit

hit

hit

verse

chorus
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frase

solo

—
o

You are logged with Apple account

Printer:
Presets:
Copies: 1

Pages:

PDF v Show Details Cancel

Export TimeCode2 for gma2

Track1  Track 2

Fade Color Info
2.00
2.00
2.00
2.00
2.00
2.00

Evnart TimaCnda? far ama?

Print

PrinterBiuro

Default Settings

Black & White

Export TimeCode2 for gma2 - Light - Page

10of1

Timecode number

1

Timecode label
TC

FPS

30

Page number

1
Exec number
2
Sequence number
2
Sequence label
Video
Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps

Timecode number

1

Timecode label
TC

FPS

30

Page number

1
Exec number
1
Sequence number
1
Sequence label
Light
Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps




Export TimeCode2 for gma2
LIc M Track 2

Name

pre show

movie 1 q = 5
Printer: @ PrinterBiuro

movie 2

. Presets:  Default Settings
movie 3

movie 4 Copies: 1 < | Black & White

St Pages:

Export TimeCode2 for gma? - Video - Page

1of1

PDF v Show Details Cancel

You are logged with Apple account

Finally, you can export Cue List (Sequence) with Timecode to

Run Export TimeCode2 for gma2.

1. Click tab Settings.
2. Set directories for Timecode (importexport) and Macro — grandMA2 OnPC Folders or USB Memory Stick Folders.

Export TimeCode2 for gma2

Settings

Name "
Document folder (for repaer file)
pre show

— /Users/makus/Documents/ExportTimeCode2/Projects/ Browse

hit Export folder (default for macro: gma2/importexport, for timecode: gma2/importexport)

hit /Volumes/MAKUS/gma2 Browse
hit
hit Default fade time 2.00

verse

Purchase of subscription is possible only after logging into the account in the icati In addition to , the account
gives the ability to synchronize settings, access information on new products, faster and more reliable comact wnh support. We
never send you email and Export TimeCode2 is 100% ad free.

chorus
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frase
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You are logged with Apple account. (click to logout)

Version: Full version for three months
show tutorial on StartUp

Reset to default

You are logged with Apple account

Timecode number
1

Timecode label
TC

FPS

30

Page number
1

Exec number
2

Sequence number
2

Sequence label
Video

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps

Timecode number

1
Timecode label
TC
FPS
30

Page number
1

Exec number
1

Sequence number
1

Sequence label
Light

Page label
Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps




3. Click tab Generate files.

Export TimeCode2 for gma2
Track 1 RICTE ¢

Timecode number
1

Timecode label
TC

FPS
30

Name Time Fade Color Info
pre show 00:00:00:00 2.00
start 00:00:04:05 2.00
hit 00:00:06:06 2.00
hit 00:00:08:10 2.00
hit 00:00:10:13 2.00
hit 00:00:12:16 2.00
verse 00:00:14:18 2.00
chorus 00:00:22:29 2.00
frase 00:00:27:06 2.00
solo 00:00:31:09 2.00

Page number
1
Exec number
1
Sequence number

1

© 0O N O O b WN =

—
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Sequence label
Light
Export TimeCode2 for gma2 Page label

Do you want to merge cue in all sequence? Page
(marge don't import color and fade values) L

Cancel No
Add new track

Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account

Your Cue Lists (Sequences) with Timecode selected Page, Executor, Color, Fade, Info is ready to be imported using a Macro from folder in grandMA2 OnPC or from macro on USB Memory Stick!

Export TimeCode2 for gma2

Track 1 JRICIS ¥ Timecode number

Name Time Fade Color Info L

pre show 00:00:00:00 2.00 _ Timecode label
start 00:00:04:05 200 1N e

hit 00:00:06:06 2.00 FPS

hit 00:00:08:10 2.00 | 30

hit Goco o o ann

[}
c
@

Page number
1
Exec number

hit
verse Export TimeCode2 for gma2
chorus
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1) Copy file TC.xml from 'file:///Volumes/MAKUS/ 1

frase gma2/' to [Disk]\gma2\importexport.

Sequence number

2) Copy file M.xml form ‘file:///Volumes/MAKUS/ 1
gma2/' to [Disk]\gma2\macros

solo

=
o

Sequence label
On the Command Line in gma2, write a command: .
import "M" at macro "@" (choose a macro number) Light

and run your imported macro. Page label

OK Page

Add new track
Delete track
Generate files
Renumber
Print Cue list
Settings
Help

Our Apps
You are logged with Apple account




4. Run your show on grandMA2.
5. Select Internal Drive or USB Memory Stick - depends where you exported Cue List (Sequence) with Timecode.

en?
e Verc
show: "tc_ L
q ... changing drive to USB 1

Internal Demosho e

Backup Options

Server Backup: Auto Save:

¥, Screen 2

Sequence

Macro ;i Timecode | ©

® scquence cod s ]

(d import "M" at Macro ]J




7. Now run this Macro.

¥ Screen 2

s::::; 2;? ;i Timecode | *
- COURSE -

~ep

¥ Screen4
L4

Sequence | Light Video

Export TC
Macro Macro OF

Timecode | ©
COURSE i

L J Sequence

out Oout | S
Number Name EGE ok A SOl

Fade © Delay | Percent Mode | AE

pre show
movie 1
movie 2
movie 3
movie 4
end

<]

Fader 1 - "Page" (1 ..15)

T LT 1f
Light

10 solo

1 pre shd

=]

Button 1 - "Page" (101 .. 115)




v

Screen4

Sequence | Light

Export TC 3
Macro Macro OF TC
COURSE

0:00:00.00

Value

Fader

Button 1 - "P: (101 .. 115)

Question?
Contact us:
support@ofcourse.com.pl




